
1 

Tutorial:	
  	
  
Open	
  Source	
  Tools	
  for	
  Data	
  Analysis	
  and	
  Visualiza9on	
  
	
  
Katy	
  Börner	
  
Victor	
  H.	
  Yngve	
  Professor	
  of	
  Informa5on	
  Science	
  
Director,	
  Cyberinfrastructure	
  for	
  Network	
  Science	
  Center	
  
School	
  of	
  Informa5cs	
  and	
  Compu5ng	
  and	
  	
  
Indiana	
  University	
  Network	
  Science	
  Ins5tute	
  
Indiana	
  University,	
  USA	
  
	
  
CDC,	
  Atlanta,	
  GA	
  
	
  
8:30-­‐11:30	
  AM	
  EST	
  
February	
  5,	
  2016	
  
	
  

	
  
	
  
Please	
  	
  
-­‐  download	
  the	
  Sci2	
  Tool	
  from	
  hIp://sci2.cns.iu.edu	
  	
  
-­‐  these	
  slides	
  hIp://cns.iu.edu/docs/presenta5ons/2016-­‐borner-­‐cdc-­‐tutorial.pdf	
  	
  	
  
-­‐  and	
  complete	
  the	
  Pre-­‐Tutorial	
  Ques5onnaire	
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Tutorial Overview 

8:30	
  	
  Welcome	
  and	
  Overview	
  of	
  Tutorial	
  and	
  AIendees	
  
9:00	
  	
  The	
  Sci2	
  Tool	
  	
  	
  
•  Download	
  and	
  run	
  the	
  Sci2	
  Tool	
  
•  ONE	
  dataset,	
  MANY	
  analyses	
  and	
  visualiza5ons	
  
9:30	
  Sci2	
  Tool	
  Workflows	
  
•  Temporal	
  Analysis:	
  Horizontal	
  line	
  graph	
  of	
  NSF	
  projects	
  
•  Geospa5al	
  Analysis:	
  US	
  and	
  world	
  maps	
  
•  Geospa5al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora5on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza5on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
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The	
  Sci2	
  Tool:	
  	
  
A	
  Plug-­‐and-­‐Play	
  Macroscope	
  that	
  implements	
  	
  

the	
  Visualiza9on	
  Framework	
  

7 

Software, Datasets, Plugins, and Documentation 
 

8 

•  These	
  slides	
  	
  
hIp://cns.iu.edu/docs/presenta5ons/2016-­‐borner-­‐cdc-­‐tutorial.pdf	
  	
  	
  

•  Sci2	
  Tool	
  Manual	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
hIp://sci2.wiki.cns.iu.edu	
  	
  

•  Sci2	
  Tool	
  v1.2	
  beta	
  
hIp://sci2.cns.iu.edu	
  

•  Addi5onal	
  Datasets	
  	
  
hIp://sci2.wiki.cns.iu.edu/2.5+Sample+Datasets	
  	
  	
  

•  Addi5onal	
  Plugins	
  
hIp://sci2.wiki.cns.iu.edu/3.2+Addi5onal+Plugins	
  	
  	
  

	
  

Make	
  sure	
  you	
  have	
  Java	
  1.6	
  (64-­‐bit,	
  if	
  you	
  selected	
  64-­‐bit)	
  or	
  higher	
  installed	
  or	
  
download	
  from	
  hIp://www.java.com/en/download.	
  To	
  check	
  your	
  Java	
  version,	
  
open	
  a	
  terminal	
  and	
  run	
  'java	
  -­‐version'.	
  
Some	
  visualiza5ons	
  are	
  saved	
  as	
  Postscript	
  files.	
  A	
  free	
  Postscript	
  to	
  PDF	
  viewer	
  is	
  
at	
  hIp://ps2pdf.com	
  and	
  a	
  free	
  PDF	
  Viewer	
  at	
  
hIp://www.adobe.com/products/reader.html.	
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Install and Run Sci2  

9 

Sci2	
  Tool	
  runs	
  on	
  Windows,	
  Mac,	
  and	
  Linux.	
  	
  
	
  
	
  
	
  
	
  
Unzip.	
  
	
  
	
  
	
  
	
  
	
  
	
  
Run	
  /sci2/sci2.exe	
  
	
  
	
  	
  

Sci2 Tool Interface Components 
See also http://sci2.wiki.cns.iu.edu/2.2+User+Interface   

10 

	
  
Use	
  
•  Menu	
  to	
  read	
  data,	
  run	
  

algorithms.	
  
•  Console	
  to	
  see	
  work	
  log,	
  

references	
  to	
  seminal	
  works.	
  
•  Data	
  Manager	
  to	
  select,	
  view,	
  

save	
  loaded,	
  simulated,	
  or	
  
derived	
  datasets.	
  

•  Scheduler	
  to	
  see	
  status	
  of	
  
algorithm	
  execu5on.	
  	
  

All	
  workflows	
  are	
  recorded	
  into	
  a	
  log	
  file	
  (see	
  /sci2/logs/…),	
  and	
  can	
  be	
  re-­‐run	
  for	
  
easy	
  replica5on.	
  If	
  errors	
  occur,	
  they	
  are	
  saved	
  in	
  a	
  error	
  log	
  to	
  ease	
  bug	
  repor5ng.	
  
All	
  algorithms	
  are	
  documented	
  online;	
  workflows	
  are	
  given	
  in	
  Sci2	
  Manual	
  at	
  
hIp://sci2.wiki.cns.iu.edu	
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Sci2 Tool Interface Components 
Download for free at http://sci2.cns.iu.edu    

11 

	
  
	
  	
  

Load	
  One	
  File	
  and	
  Run	
  Many	
  Analyses	
  and	
  Visualiza5ons	
  

12 

	
  
	
  	
  

Times	
  
Cited	
  

Publica9on	
  
Year	
  

City	
  of	
  
Publisher	
  

Country	
  Journal	
  Title	
  
(Full)	
  

Title	
   Subject	
  
Category	
  

Authors	
  

12	
   2011	
   NEW	
  YORK	
   USA	
   COMMUNIC
ATIONS	
  OF	
  
THE	
  ACM	
  

Plug-­‐and-­‐Play	
  
Macroscopes	
  

Computer	
  
Science	
  

Borner,	
  K	
  

18	
   2010	
   MALDEN	
   USA	
   CTS-­‐
CLINICAL	
  
AND	
  
TRANSLATIO
NAL	
  
SCIENCE	
  

Advancing	
  the	
  Science	
  
of	
  Team	
  Science	
  

Research	
  &	
  
Experimental	
  
Medicine	
  

Falk-­‐Krzesinski,	
  HJ|Borner,	
  
K|Contractor,	
  N|Fiore,	
  
SM|Hall,	
  KL|Keyton,	
  J|
Spring,	
  B|Stokols,	
  D|
Trochim,	
  W|Uzzi,	
  B	
  

13	
   2010	
   WASHINGTON	
  USA	
   SCIENCE	
  
TRANSLATIO
NAL	
  
MEDICINE	
  

A	
  Mul5-­‐Level	
  Systems	
  
Perspec5ve	
  for	
  the	
  
Science	
  of	
  Team	
  
Science	
  

Cell	
  Biology	
  |
Research	
  &	
  
Experimental	
  
Medicine	
  

Borner,	
  K|Contractor,	
  N|
Falk-­‐Krzesinski,	
  HJ|Fiore,	
  
SM|Hall,	
  KL|Keyton,	
  J|
Spring,	
  B|Stokols,	
  D|
Trochim,	
  W|Uzzi,	
  B	
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  USA	
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TRANSLATIO
NAL	
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A	
  Mul5-­‐Level	
  Systems	
  
Perspec5ve	
  for	
  the	
  
Science	
  of	
  Team	
  
Science	
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Research	
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Trochim,	
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  B	
  

Co-­‐author	
  and	
  	
  
many	
  other	
  	
  
bi-­‐modal	
  networks.	
  
	
  	
  

Load	
  One	
  File	
  and	
  Run	
  Many	
  Analyses	
  and	
  Visualiza5ons	
  

14 

	
  
	
  	
  

Download	
  	
  20publica5ons.csv	
  from	
  
hIp://wiki.cns.iu.edu/download/aIachments/
1245848/20publica5ons.csv?
version=1&modifica5onDate=1403450235951	
  	
  
	
  
In	
  Sci2,	
  use	
  ‘File	
  >	
  Load’	
  and	
  load	
  file	
  as	
  ‘Standard	
  
csv	
  format’.	
  	
  
Run	
  ‘Data	
  Prepara5on	
  >	
  Extract	
  Co-­‐Occurrence	
  
Network’	
  with	
  parameters:	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
Co-­‐author	
  network	
  will	
  appear	
  in	
  Data	
  Manager.	
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Load	
  One	
  File	
  and	
  Run	
  Many	
  Analyses	
  and	
  Visualiza5ons	
  

15 

	
  
	
  	
  
Run	
  ‘Analysis	
  >	
  Network	
  Analysis	
  Toolkit	
  (NAT)’	
  to	
  get	
  basic	
  proper5es:	
  
	
  
Nodes:	
  65	
  
Isolated	
  nodes:	
  0	
  
Edges:	
  404	
  
No	
  self	
  loops	
  were	
  discovered.	
  	
  
Average	
  degree:	
  12.4308	
  
The	
  largest	
  connected	
  component	
  consists	
  of	
  65	
  nodes.	
  
Density	
  (disregarding	
  weights):	
  0.1942	
  	
  
	
  
Select	
  ‘Extracted	
  Network	
  on	
  Column	
  Authors’	
  network	
  in	
  Data	
  Manager	
  and	
  run	
  
‘Visualiza5on	
  >	
  GUESS’	
  to	
  open	
  GUESS	
  with	
  file	
  loaded.	
  
Ini5al	
  layout	
  is	
  random:	
  
	
  
In	
  GUESS,	
  apply	
  ‘Layout	
  >	
  GEM’:	
  
	
  

Sci2	
  Workflows	
  
	
  

Light, Robert, David E. Polley, and Katy Börner. 2014. 
"Open Data and Open Code for Big Science of Science Studies". Scientometrics 

101 (2): 1535-1551. 	
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Tutorial Overview 

8:30	
  	
  Welcome	
  and	
  Overview	
  of	
  Tutorial	
  and	
  AIendees	
  
9:00	
  	
  The	
  Sci2	
  Tool	
  	
  	
  
•  Download	
  and	
  run	
  the	
  Sci2	
  Tool	
  
•  ONE	
  dataset,	
  MANY	
  analyses	
  and	
  visualiza5ons	
  
9:30	
  Sci2	
  Tool	
  Workflows	
  
•  Temporal	
  Analysis:	
  Horizontal	
  line	
  graph	
  of	
  NSF	
  projects	
  
•  Geospa5al	
  Analysis:	
  US	
  and	
  world	
  maps	
  
•  Geospa5al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora5on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza5on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
  

17 

Horizontal line graph of  NSF projects 
See 5.2.1 Funding Profiles of  Three Universities (NSF Data)  
 

18 

Download NSF data                                  Visualize as Horizontal Line Graph  

Start date End date 

Area size equals numerical  
value, e.g., award amount. 

Text 
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Horizontal line graph of  NSF projects 

19 

NSF Awards Search via http://www.nsf.gov/awardsearch 

 
Save in CSV format as *institution*.nsf  
 

Download and load a dataset of  your choice or load one of  the sample data files, e.g., 
‘sampledata/scientometrics/nsf/Indiana.nsf.’  
Run ‘Visualization > Temporal > Temporal Bar Graph’ using parameters: 
 
 
 
 
 
 
 
 
 
 
Save ‘visualized with Horizontal Line Graph’ as ps or eps file. Convert into pdf  and view.  
Zoom to see details in visualizations of  large datasets, e.g., all NSF awards ever made. 
 

Temporal bar graph of  NSF projects 

20 
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TLS: Towards a Macroscope for Science Policy Decision Making  

SciSIP Funding  
for Sci2 Tool 
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Seven grants by 
the “Indiana 
University of 
Pennsylvania 
Research 
Institute”  should 
be excluded. 
Rerun analysis. 

TLS: Towards a Macroscope for Science Policy Decision Making  

Start date End date 

Area size equals numerical  
value, e.g., award amount. 

Text, e.g., title 

Date of  Data Download 
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Temporal bar graph of  NSF projects 

25 

More NSF data workflows can be found in wiki tutorial: 
5.1.3 Funding Profiles of  Three Researchers at Indiana University (NSF Data)  
5.2.1 Funding Profiles of  Three Universities (NSF Data)  
5.2.3 Biomedical Funding Profile of  NSF (NSF Data)  
 

Start date End date 

Area size equals numerical  
value, e.g., award amount. 

Text, e.g., title 
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26 
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27 27 

Geocoding and Geospatial Maps 
http://wiki.cns.iu.edu/display/CISHELL/Bing+Geocoder  

•  Data with 
geographic 
identifiers 

Geocode 

•  Geolocated 
data 

Aggregate (if  
necessary) •  Geographic 

identifiers 
with data 

Visualize 

Geocoordinates + numeric data 
(Proportional Symbol Map) 

Region names + numeric data 
(Choropleth Map) 

28 

 
 
 
 

 

 

28 

Load File with Address and Times Cited Fields 

Run ‘File > Load…’ and select the sample data table ‘sampledata/geo/usptoInfluenza.csv’ 
Create a map of influenza patents held by different countries. 
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29 

 
 
 
 

 

 

29 
http://wiki.cns.iu.edu/display/CISHELL/Bing+Geocoder   

Bing Geocoder 

30 

 
 
 
 

 

 

30 

Run ‘Analysis > Geospatial > Bing Geocoder’ 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using Bing Geocoder 

Enter your Bing app key.  
You can obtain one from here..   
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31 

 
 
 
 

 

 

31 

Aggregate by Country 

Aggregate Data was selected. 
Implementer(s): Chintan Tank 
Documentation: http://wiki.cns.iu.edu/display/CISHELL/Aggregate+Data 
Input Parameters: 
Aggregate on column: Country 
Delimiter for Country: |  
Longitude: AVERAGE 
Latitude: AVERAGE 
Times Cited: SUM 
Aggregated by '': All rows of  Latitude column were skipped due to no non-null, non-empty values. 
Aggregated by '': All rows of  Longitude column were skipped due to no non-null, non-empty values. 
Frequency of  unique "Country" values added to "Count" column. 
  

32 

 
 
 
 

 

 

32 

Right-click and Save map as 
PostScript file. Use PostScript 
Viewer or convert to pdf  to 
view. 

Choropleth Map  
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33 

Legend shows 
how data matches 
up with visual 
representation 

Header shows visualization type, 
data description, and creation date 

33 

Reading the Choropleth Map 

34 

 
 
 
 

 

 

34 

Proportional Symbol Map  

Right-click and Save map as 
PostScript file. Use PostScript 
Viewer or convert to pdf  to 
view. 
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35 

Legend shows how data 
matches up with visual 
representation 

Header shows visualization type, 
data description, and creation date 

35 

Reading the Proportional Symbol Map 

 
 
 
 

 

 

36 
http://wiki.cns.iu.edu/display/SCI2TUTORIAL/5.2.4+Mapping+Scientometrics+%28ISI+Data%29 
 

Relevant Sci2 Manual entry 
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  projects	
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  US	
  and	
  world	
  maps	
  
•  Geospa9al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora5on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza5on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
  

37 

Geomap with Gephi Network Overlay 
See 4.7.6 on http://sci2.wiki.cns.iu.edu  

38 

Use Bing Geocoder to identify Latitude, Longitude for each geolocation 
Extract attributes per geolocation, e.g., total times cited (TC) 
Extract linkages and their attributes, e.g., number of  co-occurences 
See sample /geo/LaszloBarabasiGeo.net with co-occurrence of  “Research 
Addresses” and full counting of  TC per geolocation. 
 
 
 

File with 
geolocations and 
linkage info, e.g., 
an isi biblio-
graphy file. 

Read into Sci2 Tool to generate 
geomap and network file 

Layout network in Gephi 
 

Combine geomap and 
network in Photoshop 
 

+
 
 

=
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39 

http://sci2.wiki.cns.iu.edu/display/SCI2TUTORIAL/4.7+Geospatial+Analysis+%28Where
%29#4.7GeospatialAnalysis%28Where%29-4.7.6UsingGephitoRenderNetworksOverlaidonGeoMaps  

Relevant Sci2 Manual entry 

 
 
 
 

 

 

40 

Use Sci2 Tool to Generate Geomap and Network File 

Read prepared .net file and run: 
 
 
 
 
 
 
 
 
 
 
 
Save map file as Postscript file and use Adobe or other view to read. It looks like: 
 
 
Save .net file as GraphML (Prefuse) and  
rename to .graphml so that Gephi can read it. 
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41 

Use Gephi to Generate Network Layout 

Start gephi. Use New Project > Open a graph file to read .graphml file that Sci2 generated. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Follow instructions in online tutorial on Manipulating the Network File in Gephi 
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Use Gephi to Generate Network Layout 

Color or size code the “Near Alaska” and “Near Antarctica” anchor nodes to ease alignment 
of  geomap and network overlay, see instructions in online tutorial on Manipulating the 
Network File in Gephi. Save result using File > Export > SVG/PDF file. 
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Use Photoshop to Overlay Network on Geomap 

Load geomap and network files into Photoshop. Select ‘network’ layer an use ‘Right click, 
Duplicate Layer’ to copy network over to ‘geomap’ file as a second layer.  
Use Edit > Transform > Scale’ and align using the “Near Antarctica” anchor nodes, see 
instructions in online tutorial on Creating the Visualization in Photoshop. 
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Use Photoshop to Overlay Network on Geomap 
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Delete anchor nodes and save in preferred format. 

45 

Practice these steps using “LaszloBarabasi-collaborations.net” linked from Sci2 wiki:  
4.7.6 Using Gephi to Render Networks Overlaid on GeoMaps 
 
  

46 

Rounded edges might increase legibility of  
overlapping lines. 
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Tutorial Overview 

8:30	
  	
  Welcome	
  and	
  Overview	
  of	
  Tutorial	
  and	
  AIendees	
  
9:00	
  	
  The	
  Sci2	
  Tool	
  	
  	
  
•  Download	
  and	
  run	
  the	
  Sci2	
  Tool	
  
•  ONE	
  dataset,	
  MANY	
  analyses	
  and	
  visualiza5ons	
  
9:30	
  Sci2	
  Tool	
  Workflows	
  
•  Temporal	
  Analysis:	
  Horizontal	
  line	
  graph	
  of	
  NSF	
  projects	
  
•  Geospa5al	
  Analysis:	
  US	
  and	
  world	
  maps	
  
•  Geospa5al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora5on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza5on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
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Topical Analysis:  
Research Profiles 

Data: WoS and Scopus paper level data for 
2001–2010, about 25,000 separate journals, 
proceedings, and series. 
Similarity Metric:  Combination of 
bibliographic coupling and keyword vectors. 
Number of Disciplines:  554 journal clusters 
further aggregated into 13 main disciplines. 
Börner, Katy, Richard Klavans, et al. (2012) Design 
and Update of  a Classification System: The UCSD 
Map of  Science. PLoS ONE 7(7): e39464. 
doi:10.1371/journal.pone.0039464  
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Research Profiles—Publication Data 

 
Load an ISI (*.isi), Bibtex (*.bib), Endnote Export Format (*.enw), Scopus csv 
(*.scopus) file such as /sci2/sampledata/scientometrics/isi/FourNetSciResearchers.isi 
 
 
 
 
 
 
 
Run ‘Visualization > Topical > Science Map via Journals’ 
using parameters given to the right. 
 
Postscript file will appear in Data Manager.  
Save and open with a Postscript Viewer. 
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Research Profiles—Existing Classifications 

In addition to using journal names to 
-  Map career trajectories 
-  Identify evolving expertise areas 
-  Compare expertise profiles 
Existing classifications can be aligned and used to generate science map overlays. 
 
 
 

 
 
 
 
 
Run Visualization > Topical > Science Map via 554 Fields 
using parameters given to the right. 
Postscript file will appear in Data Manager.  
Save and open with a Postscript Viewer. 

54 

 
 
 
 

 

 

Align Science Basemaps using the Sci2 Tool 

 
 
 
 
 
 
 
 
 
UCSD Map                           Loet et al science maps ISI categories     http://vosviewer.com 
 
 
 
 
 
 
 
 
                                                                                                            NIH Map 
Elsevier’s SciVal Map                        Science-Metrix.com                     (https://app.nihmaps.org)  
 
 
 
 
 
-  NIH Map  
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Tutorial Overview 

8:30	
  	
  Welcome	
  and	
  Overview	
  of	
  Tutorial	
  and	
  AIendees	
  
9:00	
  	
  The	
  Sci2	
  Tool	
  	
  	
  
•  Download	
  and	
  run	
  the	
  Sci2	
  Tool	
  
•  ONE	
  dataset,	
  MANY	
  analyses	
  and	
  visualiza5ons	
  
9:30	
  Sci2	
  Tool	
  Workflows	
  
•  Temporal	
  Analysis:	
  Horizontal	
  line	
  graph	
  of	
  NSF	
  projects	
  
•  Geospa5al	
  Analysis:	
  US	
  and	
  world	
  maps	
  
•  Geospa5al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora5on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza5on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
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56 

General Network Extraction: 
Weighted, Undirected Co-Occurrence Network 

Author co-occurrence network 

56 

*Vertices 6 
1 A1  
2 A6  
3 A2  
4 A3  
5 A5  
6 A4  
*Edges 6 
2 3 2  
1 4 1  
1 5 1  
5 6 1  
1 6 1  
2 5 1  
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57 

General Network Extraction: 
Unweighted, Directed Bipartite Network 

Paper-author bipartite (2-mode) network 

*Vertices 12 
1 P1 bipartitetype "Paper"  
2 A1 bipartitetype "Authors"  
3 P2 bipartitetype "Paper"  
4 A2 bipartitetype "Authors"  
5 A6 bipartitetype "Authors"  
6 P3 bipartitetype "Paper"  
7 A3 bipartitetype "Authors"  
8 P4 bipartitetype "Paper"  
9 A4 bipartitetype "Authors"  
10 A5 bipartitetype "Authors"  
11 P5 bipartitetype "Paper"  
12 P6 bipartitetype "Paper"  
*Arcs  
1 2  
3 4  
3 5  
6 2  
6 7  
8 2  
8 10  
8 9  
11 5  
11 10  
12 4  
12 5  

Author 
Paper 

58 

General Network Extraction: 
Unweighted, Directed Network 

58 

*Vertices 12 
1 P1 indegree 0  
2 A1 indegree 3  
3 P2 indegree 0  
4 A2 indegree 2  
5 A6 indegree 3  
6 P3 indegree 0  
7 A3 indegree 1  
8 P4 indegree 0  
9 A4 indegree 1  
10 A5 indegree 2  
11 P5 indegree 0  
12 P6 indegree 0  
*Arcs  
1 2  
3 4  
3 5  
6 2  
6 7  
8 10  
8 2  
8 9  
11 10  
11 5  
12 4  
12 5  

Author 
Paper 
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59 

General Network Extraction: 
Unweighted, Directed Paper-Citation Network 

59 

*Vertices 6 
1 P1  
2 P2  
3 P3  
4 P4  
5 P5  
6 P6  
*Arcs  
2 1  
3 1  
3 2  
4 2  
5 4  
5 3  
5 1  
5 2  
6 5  

1970           1980         1990        1995        2000 

Arcs from  papers to references 

60 

General Network Extraction: 
Unweighted, Directed Bi-Partite Network 

60 

*Vertices 11 
1 P1 bipartitetype "Paper"  
2 P2 bipartitetype "Paper"  
3 P1 bipartitetype "References"  
4 P3 bipartitetype "Paper"  
5 P2 bipartitetype "References"  
6 P4 bipartitetype "Paper"  
7 P5 bipartitetype "Paper"  
8 P4 bipartitetype "References"  
9 P3 bipartitetype "References"  
10 P6 bipartitetype "Paper"  
11 P5 bipartitetype "References"  
*Arcs  
2 3  
4 3  
4 5  
6 5  
7 3  
7 9  
7 5  
7 8  
10 11  WRONG!!! 
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61 

ISI Paper-Citation Network Extraction 
 

61 
2000            2001            2002 

Arcs from  references to papers— 
in the direction of  information flow 

Tutorial Overview 

8:30	
  	
  Welcome	
  and	
  Overview	
  of	
  Tutorial	
  and	
  AIendees	
  
9:00	
  	
  The	
  Sci2	
  Tool	
  	
  	
  
•  Download	
  and	
  run	
  the	
  Sci2	
  Tool	
  
•  ONE	
  dataset,	
  MANY	
  analyses	
  and	
  visualiza5ons	
  
9:30	
  Sci2	
  Tool	
  Workflows	
  
•  Temporal	
  Analysis:	
  Horizontal	
  line	
  graph	
  of	
  NSF	
  projects	
  
•  Geospa5al	
  Analysis:	
  US	
  and	
  world	
  maps	
  
•  Geospa5al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora9on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza5on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
  

62 
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Evolving collaboration networks 

63 

Evolving Collaboration Networks 

64 

Load isi formatted file 
 
 
 
 
 
 
As csv, file looks like: 
 
 
 
 
Visualize each time slide separately:  
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65 
http://sci2.wiki.cns.iu.edu/5.1.2+Time+Slicing+of+Co-Authorship+Networks+(ISI+Data)     

Relevant Sci2 Manual entry 
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http://sci2.wiki.cns.iu.edu/5.1.2+Time+Slicing+of+Co-Authorship+Networks+(ISI+Data)     

Slice Table by Time 
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http://sci2.wiki.cns.iu.edu/5.1.2+Time+Slicing+of+Co-Authorship+Networks+(ISI+Data)     

Visualize Each Network, Keep Node Positions 

1.  To see the evolution of  Vespignani's co-authorship network over time, check ‘cumulative’.  

2.  Extract co-authorship networks one at a time for each sliced time table using 'Data 
Preparation > Extract Co-Author Network', making sure to select "ISI" from the pop-up 
window during the extraction.   

3.  To view each of  the Co-Authorship Networks over time using the same graph layout, 
begin by clicking on longest slice network (the 'Extracted Co-Authorship Network' under 'slice 
from beginning of  1990 to end of  2006 (101 records)') in the data manager. Visualize it in 
GUESS using 'Visualization > Networks > ���GUESS'.  

4.  From here, run 'Layout > GEM' followed by 'Layout > Bin Pack'.  Run 'Script > Run Script 
…' and select ' yoursci2directory/scripts/GUESS/co-author-nw.py'. 

5.  In order to save the x, y coordinates of  each node and to apply them to the other time 
slices in GUESS, select 'File > Export Node Positions' and save the result as 'yoursci2directory/
NodePositions.csv'. Load the remaining three networks in GUESS using the steps described 
above and for each network visualization, run 'File > Import Node Positions' and open 
'yoursci2directory/NodePositions.csv'.  

6.  To match the resulting networks stylistically with the original visualization, run 'Script > Run 
Script …' and select 'yoursci2directory/scripts/GUESS/co-author-nw.py', followed by 'Layout > Bin 
Pack', for each.    
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http://sci2.wiki.cns.iu.edu/5.1.2+Time+Slicing+of+Co-Authorship+Networks+(ISI+Data)     

Visualize Each Network, Keep Node Positions 
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http://cishell.wiki.cns.iu.edu/Slice+Table+by+Time    

Relevant CIShell plugin 
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Network Visualization with GUESS 

Pan: 
“grab” the background 
by holding left-click and 
moving your mouse. 
 

Zoom: 
Using scroll wheel, press 
the “+” and “-” buttons 
in the upper-left hand 
corner, or right-click and 
move the mouse left or 
right. Center graph by 
selecting ‘View -> 
Center’. 
 

Select        to select/
move single nodes. Hold 
down ‘Shift’ to select 
multiple. 
 

Right click node/edge to 
modify Color, Shape, etc. 
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Network Visualization  
with GUESS 

 
Graph Modifier: 
Select “all nodes” in the Object 
drop-down menu and click ‘Show 
Label’ button.  
 
Select ‘Resize Linear > Nodes > 
times_cited’  drop-down menu, 
then type “5” and “20” into the 
From” and To” Value box 
separately. Then select ‘Do Resize 
Linear’. 
 
Select ‘Colorize> 
Nodes>totalities’, then select 
white and enter (204,0,51) in the 
pop-up color boxes on in the 
“From” and “To” buttons. 
 
Select “Format Node Labels”, 
replace default text {originallabel} 
with your own label in the pop-up 
box ‘Enter a formatting string for 
node labels.’ 
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Network Visualization with GUESS 

Interpreter uses Jython a combination of  Java and Python. 
 
Try 
resizeLinear(times_cited,1,20) 
colorize(times_cited, white, red) 
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BREAK	
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Tutorial Overview 

8:30	
  	
  Welcome	
  and	
  Overview	
  of	
  Tutorial	
  and	
  AIendees	
  
9:00	
  	
  The	
  Sci2	
  Tool	
  	
  	
  
•  Download	
  and	
  run	
  the	
  Sci2	
  Tool	
  
•  ONE	
  dataset,	
  MANY	
  analyses	
  and	
  visualiza5ons	
  
9:30	
  Sci2	
  Tool	
  Workflows	
  
•  Temporal	
  Analysis:	
  Horizontal	
  line	
  graph	
  of	
  NSF	
  projects	
  
•  Geospa5al	
  Analysis:	
  US	
  and	
  world	
  maps	
  
•  Geospa5al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora5on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza9on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
  

74 
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Visualiza9on	
  Framework	
  

75 

Theore9cally	
  Grounded	
  and	
  Prac9cally	
  Useful	
  
Visualiza9on	
  Framework	
  	
  
	
  
developed	
  to	
  empower	
  the	
  broadest	
  spectrum	
  of	
  users	
  to	
  read	
  
and	
  make	
  data	
  visualiza5ons	
  that	
  are	
  useful	
  and	
  meaningful	
  to	
  
them.	
  	
  
	
  
The	
  visualiza5on	
  framework	
  was	
  used	
  to	
  
•  design	
  the	
  aforemen5oned	
  study	
  and	
  	
  
•  develop	
  plug-­‐and-­‐play	
  macroscope	
  tools	
  that	
  improve	
  the	
  

data	
  visualiza5on	
  literacy	
  of	
  researchers,	
  prac55oners,	
  
IVMOOC	
  students,	
  museum	
  visitors,	
  and	
  others.	
  	
  

Börner,	
  Katy.	
  2015.	
  Atlas	
  of	
  Knowledge:	
  Anyone	
  Can	
  Map.	
  The	
  MIT	
  Press.	
  
hIp://scimaps.org/atlas2	
  
	
  

76 
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Tasks	
  

 

77 See	
  page	
  5	
  

Workflow	
  Design	
  

 

Börner, Katy. 2015. Atlas of Knowledge: Anyone Can Map. The MIT Press. 
http://scimaps.org/atlas2 

78 
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Needs-­‐Driven	
  Workflow	
  Design	
  

Stakeholders	
  

Data	
  

READ	
   ANALYZE	
   VISUALIZE	
  

DEPLOY	
  

Valida5on	
  
	
  

Interpreta5on	
  

Visually	
  
encode	
  
data	
  
	
  
	
  

Overlay	
  
data	
  
	
  
	
  

Select	
  
visualiz.	
  
type	
  

Types	
  and	
  levels	
  of	
  analysis	
  determine	
  
data,	
  algorithms	
  &	
  parameters,	
  and	
  	
  
deployment	
  

Needs-­‐Driven	
  Workflow	
  Design	
  

Stakeholders	
  

Data	
  

READ	
   ANALYZE	
   VISUALIZE	
  

DEPLOY	
  

Valida5on	
  
	
  

Interpreta5on	
  

Visually	
  
encode	
  
data	
  
	
  
	
  

Overlay	
  
data	
  
	
  
	
  

Select	
  
visualiz.	
  
type	
  

Types	
  and	
  levels	
  of	
  analysis	
  determine	
  
data,	
  algorithms	
  &	
  parameters,	
  and	
  	
  
deployment	
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Types	
  

 

Börner, Katy. 2015. Atlas of Knowledge: Anyone Can Map. The MIT Press. 
http://scimaps.org/atlas2 

81 

Types	
  

 

82 
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83 See	
  page	
  24	
  

84 

Visualiza5on	
  Types	
  (Reference	
  Systems)	
  

1.   Charts:	
  No	
  reference	
  system—e.g.,	
  Wordle.com,	
  pie	
  charts	
  

2.   Tables:	
  Categorical	
  axes	
  that	
  can	
  be	
  selected,	
  reordered;	
  cells	
  
can	
  be	
  color	
  coded	
  and	
  might	
  contain	
  propor5onal	
  symbols.	
  
Special	
  kind	
  of	
  graph.	
  	
  

3.   Graphs:	
  Quan5ta5ve	
  or	
  qualita5ve	
  (categorical)	
  axes.	
  
Timelines,	
  bar	
  graphs,	
  scaIer	
  plots.	
  	
  

4.   Geospa9al	
  maps:	
  Use	
  la5tude	
  and	
  longitude	
  reference	
  
system.	
  World	
  or	
  city	
  maps.	
  

5.   Network	
  layouts:	
  Node	
  posi5on	
  might	
  depends	
  on	
  node	
  
aIributes	
  or	
  node	
  similarity.	
  Trees:	
  hierarchies,	
  taxonomies,	
  
genealogies.	
  Networks:	
  social	
  networks,	
  migra5on	
  flows.	
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Types	
  

 

Börner, Katy. 2015. Atlas of Knowledge: Anyone Can Map. The MIT Press. 
http://scimaps.org/atlas2 

85 

86 
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87 See	
  page	
  36	
  

88 See	
  pages	
  36-­‐39	
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Tutorial Overview 

8:30	
  	
  Welcome	
  and	
  Overview	
  of	
  Tutorial	
  and	
  AIendees	
  
9:00	
  	
  The	
  Sci2	
  Tool	
  	
  	
  
•  Download	
  and	
  run	
  the	
  Sci2	
  Tool	
  
•  ONE	
  dataset,	
  MANY	
  analyses	
  and	
  visualiza5ons	
  
9:30	
  Sci2	
  Tool	
  Workflows	
  
•  Temporal	
  Analysis:	
  Horizontal	
  line	
  graph	
  of	
  NSF	
  projects	
  
•  Geospa5al	
  Analysis:	
  US	
  and	
  world	
  maps	
  
•  Geospa5al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora5on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza5on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
  

89 

Informa9on	
  Visualiza9on	
  MOOC	
  (IVMOOC)	
  
Teaches	
  the	
  	
  

Visualiza9on	
  Framework	
  and	
  the	
  Sci2	
  Tool	
  

90 
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Register	
  for	
  free:	
  hIp://ivmooc.cns.iu.edu.	
  Class	
  started	
  Jan	
  12,	
  2016.	
  

The	
  Informa5on	
  Visualiza5on	
  MOOC	
  
ivmooc.cns.iu.edu	
  

Students	
  from	
  more	
  than	
  100	
  countries	
  
350+	
  faculty	
  members	
  

#ivmooc	
  

92 
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Course	
  Schedule	
  
Part	
  1:	
  Theory	
  and	
  Hands-­‐On	
  
•  Session	
  1	
  –	
  Workflow	
  Design	
  and	
  Visualiza5on	
  Framework	
  
•  Session	
  2	
  –	
  “When:”	
  Temporal	
  Data	
  
•  Session	
  3	
  –	
  “Where:”	
  Geospa5al	
  Data	
  
•  Session	
  4	
  –	
  “What:”	
  Topical	
  Data	
  
Mid-­‐Term	
  
•  Session	
  5	
  –	
  “With	
  Whom:”	
  Trees	
  
•  Session	
  6	
  –	
  “With	
  Whom:”	
  Networks	
  
•  Session	
  7	
  –	
  Dynamic	
  Visualiza5ons	
  and	
  Deployment	
  
Final	
  Exam	
  
	
  
Part	
  2:	
  Students	
  work	
  in	
  teams	
  on	
  client	
  projects.	
  
	
  
Final	
  grade	
  is	
  based	
  on	
  Class	
  Par5cipa5on	
  (10%),	
  Midterm	
  (30%),	
  Final	
  Exam	
  
(30%),	
  and	
  Client	
  Project(30%).	
  	
  
	
  

93 

Teaches	
  9meless	
  knowledge:	
  
Visualiza5on	
  framework—
exemplified	
  using	
  generic	
  
visualiza5on	
  examples	
  and	
  
pioneering	
  visualiza5ons.	
  	
  

Teaches	
  9mely	
  
knowledge:	
  
Advanced	
  algorithms,	
  
tools,	
  and	
  hands-­‐on	
  
workflows.	
  

Books	
  Used	
  in	
  the	
  IVMOOC	
  

94 



48 

Visualiza5on	
  Frameworks	
  

How	
  to	
  Classify	
  Different	
  Visualiza5ons?	
  

By	
  
•  User	
  insight	
  needs?	
  
•  User	
  task	
  types?	
  

•  Data	
  to	
  be	
  visualized?	
  	
  
•  Data	
  transforma5on?	
  

•  Visualiza5on	
  technique?	
  
•  Visual	
  mapping	
  transforma5on?	
  
•  Interac5on	
  techniques?	
  

•  Or	
  ?	
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97 

Find	
  your	
  way	
  

Find	
  collaborators,	
  friends	
  

Iden5fy	
  trends	
  

Terabytes	
  of	
  data	
  

Descrip5ve	
  &	
  
Predic5ve	
  
Models	
  

97 

Different	
  Ques5on	
  Types	
  

98 

Different	
  Levels	
  of	
  Abstrac5on/Analysis	
  

	
  
Macro/Global	
  
Popula5on	
  Level	
  
	
  
	
  
	
  
Meso/Local	
  
Group	
  Level	
  
	
  
	
  
Micro	
  
Individual	
  Level	
  



50 

Type	
  of	
  Analysis	
  vs.	
  Level	
  of	
  Analysis	
  

Micro/Individual	
  
(1-­‐100	
  records)	
  

Meso/Local	
  
(101–10,000	
  records)	
  

Macro/Global	
  
(10,000	
  <	
  records)	
  	
  

StaHsHcal	
  Analysis/
Profiling	
  	
  

Individual	
  person	
  and	
  
their	
  exper5se	
  profiles	
  

Larger	
  labs,	
  centers,	
  
universi5es,	
  research	
  
domains,	
  or	
  states	
  

All	
  of	
  NSF,	
  all	
  of	
  USA,	
  all	
  
of	
  science.	
  

Temporal	
  Analysis	
  
(When)	
  

Funding	
  por{olio	
  of	
  
one	
  individual	
  

Mapping	
  topic	
  bursts	
  
in	
  20	
  years	
  of	
  PNAS	
  

113	
  years	
  of	
  physics	
  
research	
  

GeospaHal	
  Analysis	
  
(Where)	
  

Career	
  trajectory	
  of	
  one	
  
individual	
  	
  	
  

Mapping	
  a	
  state’s	
  
intellectual	
  landscape	
  

PNAS	
  publica5ons	
  	
  

Topical	
  Analysis	
  	
  
(What)	
  

Base	
  knowledge	
  from	
  
which	
  one	
  grant	
  draws.	
  

Knowledge	
  flows	
  in	
  
chemistry	
  research	
  	
  

VxOrd/Topic	
  maps	
  of	
  
NIH	
  funding	
  

Network	
  Analysis	
  	
  
(With	
  Whom?)	
  

NSF	
  Co-­‐PI	
  network	
  of	
  
one	
  individual	
  	
  	
  

Co-­‐author	
  network	
  	
   NIH’s	
  core	
  competency	
  	
  

99 

Type	
  of	
  Analysis	
  vs.	
  Level	
  of	
  Analysis	
  

Micro/Individual	
  
(1-­‐100	
  records)	
  

Meso/Local	
  
(101–10,000	
  records)	
  

Macro/Global	
  
(10,000	
  <	
  records)	
  	
  

StaHsHcal	
  Analysis/
Profiling	
  	
  

Individual	
  person	
  and	
  
their	
  exper5se	
  profiles	
  

Larger	
  labs,	
  centers,	
  
universi5es,	
  research	
  
domains,	
  or	
  states	
  

All	
  of	
  NSF,	
  all	
  of	
  USA,	
  all	
  
of	
  science.	
  

Temporal	
  Analysis	
  
(When)	
  

Funding	
  por{olio	
  of	
  
one	
  individual	
  

Mapping	
  topic	
  bursts	
  
in	
  20-­‐years	
  of	
  PNAS	
  

113	
  years	
  of	
  physics	
  
research	
  

GeospaHal	
  Analysis	
  
(Where)	
  

Career	
  trajectory	
  of	
  one	
  
individual	
  	
  	
  

Mapping	
  a	
  states	
  
intellectual	
  landscape	
  

PNAS	
  publica5ons	
  	
  

Topical	
  Analysis	
  	
  
(What)	
  

Base	
  knowledge	
  from	
  
which	
  one	
  grant	
  draws.	
  

Knowledge	
  flows	
  in	
  
chemistry	
  research	
  	
  

VxOrd/Topic	
  maps	
  of	
  
NIH	
  funding	
  

Network	
  Analysis	
  	
  
(With	
  Whom?)	
  

NSF	
  Co-­‐PI	
  network	
  of	
  
one	
  individual	
  	
  	
  

Co-­‐author	
  network	
  	
   NIH’s	
  core	
  competency	
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Clients	
  

	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
	
  
hIp://ivmooc.cns.iu.edu/clients.html	
  	
  

101 

Diogo	
  Carmo	
  	
  

102 
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mjstamper_ivmooc	
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Tutorial Overview 

8:30	
  	
  Welcome	
  and	
  Overview	
  of	
  Tutorial	
  and	
  AIendees	
  
9:00	
  	
  The	
  Sci2	
  Tool	
  	
  	
  
•  Download	
  and	
  run	
  the	
  Sci2	
  Tool	
  
•  ONE	
  dataset,	
  MANY	
  analyses	
  and	
  visualiza5ons	
  
9:30	
  Sci2	
  Tool	
  Workflows	
  
•  Temporal	
  Analysis:	
  Horizontal	
  line	
  graph	
  of	
  NSF	
  projects	
  
•  Geospa5al	
  Analysis:	
  US	
  and	
  world	
  maps	
  
•  Geospa5al	
  Analysis:	
  Geomap	
  with	
  network	
  overlays	
  
•  Topical	
  Analysis:	
  Visualize	
  research	
  profiles	
  
•  Network	
  Analysis:	
  Co-­‐occurrence	
  networks	
  and	
  bimodal	
  networks	
  
•  Network	
  Analysis:	
  Evolving	
  collabora5on	
  networks	
  
10:15	
  Networking	
  Break	
  
10:30	
  Visualiza5on	
  Framework	
  
11:00	
  IVMOOC	
  –	
  MANY	
  more	
  Workflows	
  
11:15	
  Outlook	
  and	
  Q&A	
  

11:30	
  Adjourn	
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All	
  papers,	
  maps,	
  tools,	
  talks,	
  press	
  are	
  linked	
  from	
  hIp://cns.iu.edu	
  
These	
  slides	
  will	
  soon	
  be	
  at	
  hIp://cns.iu.edu/docs/presenta5ons	
  	
  	
  	
  

	
  

CNS	
  Facebook:	
  hIp://www.facebook.com/cnscenter	
  	
  
Mapping	
  Science	
  Exhibit	
  Facebook:	
  hIp://www.facebook.com/mappingscience	
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